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Welcome to the LISST-Deep Particle Size Analyzer

Using this manual
This manual 1s divided into three sections.

Section One contains a basic introduction to the LISST-
Deep instrument and the principles of its operation.

Section Two contains overview of the operation of the
LISST-Deep in a tutorial format.

Section Three provides a detailed set of instructions for
using and caring for the instrument.

Technical specifications

The technical specifications for the LISST-Deep can be
found in Appendix A. For a listing of instrument specific
constants, as used in the software for data processing, refer
to Appendix B.

Technical assistance

To obtain technical assistance please contact your local
distributor or a Sequoia Technical Service Representative
listed below. Please be sure to include the serial number
with any correspondence.

Serial Number:
Shipment:

Factory Technical Service Representatives

Chuck Pottsmith
pottsmith@sequoiasci.com; (425) 867-2464 ext. 107

Doug Keir
keir@sequoiasci.com; (425) 867-2464 ext. 104




Section 1: The LISST-Deep Instrument

General Description
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The LISST-Deep is a deep-water version of the standard LISST-
100 instrument manufactured by Sequoia Scientific, Inc. It is
offered in two versions: anodized aluminum housing, and a
titanium housing. The aluminum housing is capable of operation
to 5000 m. The titanium housing can be used to 6500 m. Either
version is offered in Type-B (1.25 to 250 microns) or Type-C
(2.5-500 microns). The instruments have internal data storage
and batteries. Additionally, the instruments can be operated with
external power.

Insert picture here

The photograph above shows the black anodized aluminum
LISST-Deep. The instrument consists of two housings held
together by a cylindrical mid-section. The cylindrical section has
cuts for water passage. In the shorter housing, a laser collimator is
enclosed. In the longer housing section, the detection optics are
enclosed, along with the electronics and the internal battery. An
external cable provides power from the electronics housing to the
laser end. There are two underwater connectors on the electronics
housing (the longer section). The first, a 5-pin connector at center
of the endcap is for the cable to deliver power to the laser. The
second, a 5-pin connector is for communications with the
instruments. Before a deployment, this connector should either
be capped with a plug. If the LISST-Deep has the optional
SeaBird CTD Interface installed there will be a third connector.
This connector will need to be connected to the CTD Aux port
using the proper cable or the cap must be installed.

The cylindrical mid-section contains the glass pressure windows.
These windows must be cleaned with alcohol or dish-soap and
water before each deployment. Do not use abrasive powders for
cleaning.

Never mount the instrument in a way that there are bending
forces on it, as this will cause misalignment of the optics.
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Principle of Operation

Background

LISST is a product name derived from the term that describes its
operation: Laser In-Situ Scattering and Transmissiometry.

The LISST-Deep uses the technique of laser diffraction to obtain
particle size-distribution (PSD). This section describes the basic
principles of operation of the instrument.

At the heart of the instrument is an optical arrangement shown in
the cut-away illustration below.

A collimated laser beam is formed to illuminate particles in the
flow (arrow). Light scattered by these particles is collected by a
receiving lens. At the focal plane of the lens, a specially
constructed detector is placed. The detector consists of 32 photo-
active silicon rings, each ring occupying a 60° azimuth. These
rings are log-spaced, i.e. each ring diameter is a fixed ratio larger
than the previous inner ring. The inner-most ring has an inner
radius of 102 microns. Each subsequent ring grows by a ratio
1.18, so that the outer radius of the 32" ring is 20mm.

- Continued on the next page...
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Each of the rings responds to light scattered from the particles
over a small angle range. In this manner, the 32 ring detectors
measure the intensity of light scattered over 32 angular ranges. In
the Type-B instrument, the overall angle range is 0.1° to 20°. For
the Type-C instrument, it is 0.05° to 10°.

At the center of the ring-detector, a small hole allows the focused
laser beam to pass and be sensed by a photo-diode that is placed
behind the ring detector. This constitutes a measurement of
optical transmission. From this measurement, a value of beam-c
can be computed in post-processing.

Electronics in the instrument digitize and store the output of the
ring detectors and the transmission sensor. A built-in computer is
used for scheduling of measurements, for communications, and
for data storage. This computer is programmed in a version of
BASIC language. Data is stored on a non-volatile flash memory.
Even when battery power is removed, data is maintained in
memory.

The processing of the stored data to convert to size distribution is
carried out after data downloading, on the user’s PC. Software
for all operations, and data processing is provided.

For those interested in further details, please refer to the paper
(available from the company by request):

Agrawal, Y.C., and H.C. Pottsmith, 2000: Instruments for
Particle Size and Settling Velocity Observations in Sediment
Transport, Marine Geology v168/1-4, pp 89-114.
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Section 2:

Operation Overview

General
Precautions

Operational steps

Warnings

LISST-Deep is a sensitive optical instrument. Please handle it gently.
Critical alignments may be disturbed if the instrument is subjected to
shock or rough handling. Evidence of shock/rough handling will void
the warranty. Whenever in transit, store the instrument in the provided
cushioned box.

Instrument operation consists of just the following steps:

e Establish communication between LISST-Deep and a
computer (optional: erase prior data in memory);

e Change default measurement parameters if desired;

e  Start the data collection program;

e Launch the instrument;

e Upon retrieval, download data;

e Process dataona PC.

Never mount the instrument in a way that there are bending
forces on it, as this will cause misalignment of the optics.

WARNING

The LISST-Deep uses a laser diode emitting a maximum of 3 MW
of visible (red) light at a wavelength of 670nm. the laser beam
under normal circumstances is not a threat. However, if reflecting
objects are placed in the path of the laser beam, the light could be
reflected into the eye causing permanent damage.
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Getting Started

Contents of
shipping case

Step 1: Remove
Instrument from
shipping case.

Step 2: Check for
clean windows

Step 3: Attach the
Laser and
Communications
Cables

This section is designed to give the user a quick introduction to
the operating procedures for the LISST-Deep. It gives step by step
instructions to unpack, load software, and acquire data in the lab.
Following the introduction are details on each step of the process.
Table 2-1 lists the introduction steps that will be discussed.

Let us assume that you are opening the LISST-Deep shipping case
for the first time. Inside you will find the following: User’s
Manual with software disk, LISST-Deep instrument, Plastic
Instrument stands, Communications cable, Allen wrench set,
spare o-rings, and spare endcap bolts.

Start by removing the white plastic instrument stands and set
them on a flat working surface. Remove the LISST-Deep from
the case and set it on the stands. The LISST-Deep has two
distinct ends that we will refer to as the Laser endcap and the
Connector endcap. The connector endcap has two underwater
connectors that are used for communication/external power and
for the laser. The battery pack is attached to the inside of this
endcap. The Laser endcap is attached to a case that contains the
laser and optical components that generate the collimated laser
beam.

At this time let us check the optical windows to make sure that
they are clean. There are two identical windows. The best way to
check the windows is by using a flashlight. By shining light from
one side and viewing from the other the surface of the windows
can be easily checked for cleanliness. If there is dirt or
fingerprints on the windows clean them first by rinsing them with
water and then by wiping them with a soft cloth and alcohol.
Standard dish soap or glass cleaner may also be helpful. Stronger
solvents, such as acetone, can be used if necessary but is not
recommended as a general practice. In general do not use any
abrasive cleaners or wipes. Treat the windows as you would an
expensive camera lens.

If not already installed, the Laser cable will need to be
connected. It is a 3-foot cable with 5-pin connectors on both
ends. It connects the laser to the main electronics board. It is
installed from the center connector on the Connector Endcap
to the only connector on the Laser Endcap. The easiest way to
remember the configuration is that the laser cable goes from
center connector to the center connector.

Remove the Communications cable from the shipping crate. It
is the cable with the 9-pin DB-9 connector on one end and the
5-pin underwater connector on the other. Remove the
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Step 4: Install the
provided software
on your PC

Step 5: Start
TFTOOLS.EXE
communications
program

underwater cap from the Communications connector. The
connectors will all look similar and have the same number of
pins. The Communication connector is the 5-pin connector
located off-center. After removing the cap install the cable
making sure that the proper pin alignment is maintained.

At this point the instrument is ready to go. Let us install the
software that is required for operation of the instrument on to a
PC. A software disk is included with each instrument. In
addition the communication and processing programs, the disk
also contains calibration files specific for your instrument.
Copy the contents into a directory on the PC to be used. The
recommended directory is LISST. After copying the files from
the floppy to the directory, copy the LISST.INI file to the
c:\windows directory.  This file contains the calibration
constants and other settings for the LISST.EXE program.
Shortcuts to the LISST.EXE and TFTOOLS.EXE programs
are not created automatically. The user may find that shortcuts
on the desktop will simplify the operation. The Windows help
files describe how to create a shortcut on the desktop.

There are two different programs for the PC that are used with
the LISST-Deep. They are TFTOOLS.EXE and LISST.EXE.
TFTOOLS.EXE is a Windows based program that allows the
user to communicate with the datalogger inside the LISST-
Deep. TFTOOLS is used as a terminal window for the
datalogger and also is used to upload programs and download
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Step 6: Wake up
instrument from
Sleep mode

Step 7: Main
Menu options

data. The LISST.EXE program is a Windows-95/98/NT
program that processes and displays the particle size
information. At this point we will use the TFTOOLS.EXE
program. Start this program by double clicking its icon.

A terminal window will appear with menus across the top.
Select the CommPorts menu and then Serial Port... item. A
window with the baud rate and port settings will appear. The
LISST-Deep uses 19200 baud. Set the Port to the available
communications port of the PC. Select OK to save the
settings. The next time TFTOOLS.EXE is started it will use
the previous settings.

The complete communication specifications for the LISST-
Deep are: 19200 baud, 8 data bits, 1 stop bit, Handshake and
Parity should be set to None.

The LISST-Deep is shipped running a program that keeps the
instrument in its low power mode. After returning to the
Terminal window you may see a message on the screen from
the LISST-Deep. It will wake up every 10 seconds, print a
message to the screen (Deep Sleep...Enter zz now to wake up),
wait two seconds for a response, and then go back to its low-
power sleep if there is no response. Wait for the program to
display the message to the screen and then type zz and press
enter to stop the program running on the datalogger. The Main
Menu should appear.

The program running on the datalogger of the instrument
displays a menu to the screen that allows the user to setup the
instrument, acquire a background, acquire data, and operate the
instrument in a real-time mode. It also allows the user to put
the instrument in a low power sleep mode.

The main menu looks like the following:

Main Menu
1.) Display Status and Configure
2.) Acquire Background
3.) Acquire Data
4.) Acquire Data upon external power
5.) Real Time Output Mode
6.) Low Power Sleep Mode
7.) Exit program
Enter Selection:

Enter the number of the command to execute and press enter.
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Step 8: Acquire
Background data

The background scattering from the optics must be measured and
subtracted from the field data to obtain the scattering by only the
particles of interest. Before acquiring the data the instrument must
be submerged in clean water. A piece of thin clear plastic is
provided with the instrument. This plastic can be wrapped around
the sample section of the instrument and the ends sealed with
water-resistant tape. This will allow the instrument to be
“submerged” in water on the bench. The water used for the
background data must be very clean and bubble-free.

Select the Exit Program Option (7) from the menu and press
enter. This will exit the program and bring you to a # prompt.
From this prompt the user can upload programs and download
data. Before acquiring data we must first erase the contents of the
datafile. This can be done by selecting the Erase Datafile...
option from the Tattletale menu. Type Alt-r (hold down Alt and
press r) to restart the program. The main menu should appear.

Select Acquire background (2) from the menu and press enter. A
prompt will appear asking if you would like to continue. Check
the windows of the instrument to make sure that no bubbles are
stuck to the windows and press enter. Ten samples will be stored
to the datafile. When finished the main menu will appear. Exit the
program and down load the data using the Xmodem Offload...
option of the TattleTale menu. All data that has been saved since
the last time the datafile was erased will be downloaded. We will
use this data for later processing. Restart the program by typing
Alt-r.
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Step 9: Setting To set the options for use during data acquisitions, select the
Deployment Display Status and Configure option. A menu will appear similar
Options to the one shown below.

Current Status
1.) Current Date/Time = 8/24/2001 7:56:23
2.) Samples per average = 10
3.) Number of samples to acquire = 3000
4.) Time between samples (sec) =1
5.) Acquisition Delay (min) =10
Memory Used: 0 samples
Battery Voltage: 10.8 volts
Enter Selection to change or 0 to return to main menu:

This menu is used for two purposes. One is to display the current

settings. The second is to allow these settings to be changed. To

change a setting select the item number and press enter. A prompt
will appear asking for a new value. Enter the new value and press
enter. The Status menu will appear again. Press enter to return to

the main menu.

The number of samples per average is adjustable. The minimum
recommended value is 10. Higher values require more time (and
more battery) to obtain an average. When working in very clean
water 100 samples per average is highly recommended. The
figure below shows the time to acquire a sample as a function of
number of samples per average.

The variable Time between Samples is the time from the end of
the last average to the beginning of the next average. It is not the
sample interval. For example if samples per average is set to 100,
with the time between samples set to 5 seconds the actual spacing
of the stored values will be about 15.8 seconds.
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Step 10: Acquire
Field Data

Step 11: Put
instrument back to
sleep

Step 12: Exit
TFTOOLS.EXE
and start
LISST.EXE

Sample Acquisition Time vs. Samples per Average
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To acquire field data select the Acquire Data option from the
main datalogger menu. The program will start the execution of
the programmed delay. After the delay samples will be acquired,
averaged, and stored.

The program will acquire data until the selected number of
samples is reached or until the program is stopped with a ctri-c.

After stopping the program, the data will need to be offloaded as
in Step 8 above. After downloading is complete, the datafile can
be erased in preparation for the next data collection.

Entering Alt-r will restart the program. The main menu should
appear.

To put the instrument back into its low power mode select the
Low power option from the Main Menu. The instrument is now
in its low power mode. Be sure to disconnect the communications
cable for maximum battery conservation.

We will now switch to the LISST.EXE program. First we must
exit TFTOOLS.EXE by selecting QUIT from the FILE menu.
The program on the datalogger is still running. We can now start
LISST.EXE by clicking on its icon. A screen will appear with
menus across the top.
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Step 13: Build
Background
Scatter File

Step 14: Select
Output file types

Step 15: Process
Raw Data
command

Step 16: Open
View Ring and

The first step in processing data is to build a background scatter
file. This step will read the binary file that we downloaded
earlier, average the 10 samples, and store the average to an
ASCII file that we will use later for processing.

Select Build Background Scatter file from the File menu. It will
prompt you for the name of the Raw data file, select the name of
the background file that was downloaded earlier.

A screen will appear with a display showing the averaged data in
a bar chart graph. The red line is the factory background scatter
file. If the water is not clean, the windows are dirty, or if the
instrument is out of alignment it will produce signals that are
higher than the red line. If values are at or below the red line
press Accept. It will then prompt you for an output file name.
Select a unique name and press Save.

After processing the background scatter file we can now move on
to looking as some real data. The first step is to select the type of
output we would like to save. The default is to save only a binary
processed data file that can be later used for viewing the results
using the View Processed Data command. To select additional
outputs select the Output option from the Options menu. A
window will appear that lists the various options. In the Raw
Data file sections select the Build an ASCII particle size file
option. This option will create an ASCII file with the processed
data. Each sample will be a row in the file. Descriptions of the
columns can be found in Appendix B. After selecting the output
type we can move on to processing the data. Note: the output
must be selected before the processing of the data is started.

Select Open Raw Datafile from the File menu. A prompt for the
instrument type will be displayed. Select the proper type. Note:
All new instruments are Type 2 (1 - 250 microns). Next, a prompt
for the RingArea file will be displayed. Select the RingArea file
for the instrument. Similarly, a prompt for the background
scatterfile to use will be displayed. Enter the name of the file
stored in the above step. A display with two graph windows will
appear. The upper plot is a graphical representation of the 32
rings for the complete datafile. The lower plot shows the value of
a few of the auxiliary parameters. Only 400 values at a time are
display. Small triangles on the upper plot show the location of
the 400 samples in the complete datafile. Use the next button to
move through the frames of 400.

Before processing the data let us take a look at a few additional
windows that can be useful. Select View Rings from the
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Auxiliary
Parmeters

Step 17: Select
range of data to
process

Step 18: View
Processed data

Step 19: Close
program and
shutdown

DataFrames menu. A display appears that shows values of the 32
rings and the background scatterfile (red line). Then select Show
Auxiliary Parameters Frame from the DataFrames menu. This
window shows the values for the eight auxiliary parameters. The
computed value of transmission is also shown. These values are
from the sample pointed to by the vertical cursor on the lower
plot. Clicking the mouse on the lower plot will change the
location of the cursor line.

By default the complete datafile is selected for processing. By
moving the vertical cursor and pressing the Select First and Select
Last buttons a different range can be selected. Remember that
only 400 samples at a time are displayed. Use the Next button to
move to later samples. The Select First and Select Last values do
not need to be in the same frame. After selecting the range to
process press the Process File button. Text will be printed to the
screen showing the status of processing. When the processing is
complete the text on the Process File button will change to
Finished.

The raw data has now been processed into size distributions. The
data is save as a binary file with the same name as the raw data
but with a PSD extension. If the ASCII file output option was
selected is will also have been saved as the same name with a
ASC extension.

The processed data can be viewed using the Open Particle
Distribution File option from the File menu. A window with two
plots will be displayed. The right plot is the volume distribution
of particle. The volume of particle in each size class is
represented by a bar. The total volume concentration is the sum
of these values and is displayed in the lower left. The right plot is
the Volume Scattering function which is used by optical
oceanographers.

Only one sample is displayed at a time. Click the Next button to
view additional samples. The Timer button and slide control can
be used to automatically view the data in a movie-like fashion.

The Auxiliary Parameters window can be opened and will display
the values for the currently displayed sample.

After finishing the data processing close all the windows and exit
LISST.EXE.

The above steps are meant to give a brief introduction to most of
the procedures that are required to operate the LISST-Deep-
Custom. All of these steps are covered in detail in the following
sections.
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Section 3:

Operation Details

This section contains more detailed information on the operation of the LISST-
Deep than the previous section. Step-by-Step procedures are provided for
most of the typical operations. The information is organized into the following
sections: Instrument Communication and Program execution, Data Acquisition
and Storage, Data Analysis, Performance Tips, and Instrument Storage and
Maintenance.

Instrument Communication and Program Execution

Running
TFTOOLS

Communication with the LISST-Deep is via an RS-232C link. A
cable that connects the instrument to a PC has been provided. This
cable connects the 5-pin underwater connector on the instrument
to a DB-9 serial port connector. If required, DB-9 to DB-25 pin
adapters are available.

The RS232 link communicates at 19200 baud, 8 data bits, No
parity, and 1 stop bit. A communications program called
TFTOOLS.EXE has been provided for communicating with the
LISST-Deep. TFTOOLS is a DOS application which has features
built in that simplify many of the communications tasks such as
data off-loading and program loading.

Other communication software such as Windows Terminal or
Procomm can also be used. If programs other than TFTOOLS are
to be used for uploading and off-loading, a working knowledge of
ASCII and XMODEM file transfers will be required.

Running TFTOOLS, or alternate software, with the proper COM
port and communications settings will allow the user to
communicate with the instrument. If the power has been
connected as discussed in the Battery Power and Access Section
above, the LISST-Deep should respond by either displaying text
from a running program or echoing an # prompt.

Programs are retained in memory by the lithium backup battery
and will start executing when power is applied. A running
program can be stopped by pressing CTRL-C (hold down CTRL
key and press C). After a program is stopped or if no program is
loaded, pressing the ENTER key will cause an echo of the #
prompt. To restart the program enter ALT-r. The main menu
should appear.

The datalogger of the LISST-Deep is programmed with a version
of BASIC called TFBASIC. A general-purpose program has been
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loaded on to the LISST-Deep. This program will meet the needs of
most deployments. Custom programs can be provided for specific
deployment needs not covered by the standard program. Please
contact Sequoia Scientific regarding your special needs.

Data Acquisition & Storage

Main Menu

Option 1:
Display Status and
Configure

This section contains information on acquiring and storing data
on the LISST-Deep. In addition, a description of the background
scatter datafile is included.

The LISST-Deep contains a datalogger that is used to acquire and
store the raw scattering data. A program on this datalogger
displays a menu to the screen where various parameters can be set
and operations can be started. The menu is displayed below.

Main Menu
1.) Display Status and Configure
2.) Acquire Background
3.) Acquire Data
4.) Acquire Data upon external power
5.) Real Time Output Mode
6.) Low Power Sleep Mode
7.) Exit program
Enter Selection:

To select an option type the option number and press enter. A
description of each option is below

The Display Status and Configure option is used to set operation
parameters and display the current status of the battery and
memory. After selecting this option a new menu will appear
similar to the one shown below.

Current Status
1.) Current Date/Time = 8/24/1999 7:56:23
2.) Samples per average = 10
3.) Number of samples to acquire = 3000
4.) Time between samples (sec) =1
5.) Acquisition Delay (min) =10
Memory Used: 0 samples
Battery Voltage: 10.8 volts
Enter Selection to change or 0 to return to main menu:

This display acts as both a source of information as well as a
menu for changing the values.
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Selecting option 1 will allow the user to change the current date
and time through a series of prompts.

Selecting option 2 will allow the user to change the number of
samples averaged before storing. Note: the default value is 10
samples per average however it is highly recommended that a
value of 100 be used for deep water applications.

Selecting option 3 allows the selection of the number of samples
to be stored. The collection will stop when the number of
samples is reached. The collection can also be stopped with a
ctrl-c. The maximum number of samples that can be stored is
5930.

Selecting option 4 will prompt for the time to wait between the
end of a sample and the beginning of the next in integer seconds.
Note: This is not a sample rate. The actual sample rate is based on
the time to acquire a sample and the time between samples. The
figure below shows the time to acquire a sample as a function of
the number of samples per average.

Sample Acquisition Time vs. Samples per Average
12 T T T T T T

e S R R
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' Slope ='0.102 seconds/sample
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Sample Acquisition Time (seconds)
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Samples per Average

For example if 100 samples per average is used with the time
between samples set to 5 seconds the actual spacing of the stored
values will be about 15.8 seconds. The date and time of each
sample is stored in the datafile.

Selecting option 5 allows the selection of the time delay in
minutes before sampling will start. This allows the user to setup
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Option 2: Acquire
Background

Option 3: Acquire
Data

Option 4: Acquire
Data upon external
power

Option 5: Real
Time Output mode

system well before deployment.

Addition values are also displayed such as the current battery
voltage and the number of samples save in memory.

Pressing enter will return to the main menu.

Selecting Option 2 from the main menu will command the
datalogger to acquire 10 averaged data samples and record them.
After selecting Acquire background (2) from the menu a prompt
will appear asking if you would like to continue. Check the
windows of the instrument to make sure that no bubbles are stuck
to the windows and press enter. Ten samples will be stored to the
datafile. The Main menu will be display when complete. The
data will now need to be downloaded for later use in processing
of the raw data.

Selecting option 3 from the main menu will start the acqusition of
data using the programmed parameters. It will start the delay
immediately after selecting the this option. Upon completion of
the delay, data will be collected until the number of programmed
sample is reached or the collection is stopped using a ctrl-c.
Typing alt-r will restart the program and redisplay the main menu.

Selecting option 4 from the main menu will start the acqusition of
data. Data collection will not start until external power is turned
on. Before the power is turned on it will display a message that
the instrument is running on internal power, wait 2 seconds, then
return to sleep mode for 8 seconds. If Ctrl-C is pressed during
these 2 seconds the program will return to the main menu. using
the programmed parameters.

When external power is applied to either the standard
communications port or the optional CTD port the program will
display a 30 second countdown. Typing Ctrl-C will return to the
main menu. At the end of 30 seconds the specified Delay will be
started.

Upon completion of the delay, data will be collected until the
number of programmed sample is reached or the collection is
stopped using a ctrl-c.  The program will return to the Main
Menu at the completion of the samples or upon entering Ctrl-C.

Selecting option 5 will start the Real time display mode. This
mode will print the values of the 32 rings and 8 auxiliary
parameters to the screen. This can be useful in evaluating the
conditions before a background file is acquired. It will also be
used for real-time size distributions in the LISST.EXE program in
the future. The Real-Time size distributions in LISST.EXE are
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Option 6: Low
Power Sleep mode

Option 7: Exit
Program

Background

Scatter Datafile
and its

Importance

Setup for
Background

currently not supported for the LISST-Deep

Selecting Option 6 will put the instrument into a low power
mode. In this mode, it will wake up every 10 seconds, print a
message to the screen (Deep Sleep...Enter zz now to wake up),
wait two seconds for a response, and then go back to sleep if
there is no response. Wait for the program to display the
message to the screen and then type zz and press enter to stop
the program running on the datalogger. The Main Menu
should appear.

This mode is useful for saving the batteries between
deployments. For longer periods it is recommended that the
batteries be removed or disconnected.

Selecting Option 7 will stop the execution of the program and
return the # prompt. This prompt must be displayed before the
datafile can be downloaded.

As was discussed in earlier sections, the LISST-Deep uses a
custom detector to measure light scattered at small angles from
particles in water. In order to measure only the scattered light
contributed by the particles, a measurement of the background
scattering must be obtained. This background scattering can
come from a number of areas. Scratches on the windows,
imperfections on the optics, and other sources all contribute to the
scattered light. By subtracting this background scattering from
the measured data, a true measurement of the light scattered from
the particles can be obtained. The measurement of background
scattering has come to be called a "ZSCAT". The name comes
from the fact that the measurement is obtained with use of water
with zero "scatterers" or particles.

It is very important that clean and bubble free water be used. The
water can be fresh or salt water. For most applications, it has
been found that 'medical grade' distilled water is sufficient.
'Medical grade' distilled water is typically available in one gallon
containers at most pharmacies. We have found that this distilled
water tends to be a bit cleaner than typical bottled or packaged
water.

A piece of thin clear plastic is provided with the instrument. This
plastic can be wrapped around the sample section of the
instrument and the ends sealed with water-resistant tape. This
will allow the instrument to be “submerged™ in water on the
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Watch for
outgassing

Clean optics end
before ZSCAT

Avoid Direct
sunlight

bench. The water used for the background data must be very
clean and bubble-free. The use of a flashlight may be useful for
checking the cleanliness of the windows.

The instrument should be placed horizontally on the supplied
white plastic supports. Roughly 2 liters of water is needed to do a
ZSCAT.

Another consideration when acquiring a ZSCAT is "outgassing"
causing small bubbles to form on the instrument and windows.
Bubbles on the windows will greatly modify the scattering
pattern, rendering the ZSCAT useless.

Because non-optical parts of the instrument are submerged, it is
important to thoroughly clean and rinse the instrument before
acquiring a ZSCAT

Toothbrush, liquid soap and water works well for cleaning
the optical end of the instrument; do not use abrasive
powders, they will scratch optics and destroy instrument
performance.

Direct sunlight should also be avoided when obtaining a ZSCAT.
The unit is relatively insensitive to sunlight; however, bright light
can increase the noise in the measurement and give a false
background scattering measurement. It is recommended that the
end of the instrument be shrouded with a dark cloth during the
acquisition of the ZSCAT. In general, the ZSCAT should be
taken in conditions that match the deployment conditions as
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closely as possible.

The low concentration limit of LISST-Deep is very sensitive to
the ZSCAT calibration. For this reason, when working in near-
surface or mid-depth water, a good ZSCAT file should be
obtained with clean water. As particle concentrations increase,
the relative signal-to-background noise ratio also increases, thus
reducing the importance of a ZSCAT. However, ZSCATs should
always be done before an experiment.
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Data Analysis

Intro to LISST.EXE

Features of
LISST.EXE

The processing of the acquired data into particle size distributions
and volume scattering functions is done by a separate program,
LISST.EXE running on a PC with Windows-95/98/NT.

LISST.EXE 1is a 32-bit program that runs on Windows-95,
Windows-NT, or Windows-98 machine. It contains all of the
software necessary for processing of the raw data into size
distributions. Future versions will also include all of the features
that are currently covered by the DOS program, TFTOOLS.EXE.
The TFTOOLS.EXE program is only used to load and start
programs in the datalogger and to download stored data. It is not
used to process the data.

In order to process the raw laser scattering information into
particle size and concentration a series of mathematical
operations and inversions must be performed. This processing of
the data can be from stored data or from real-time data. The
processed data can be viewed on the screen and output to an
ASCII file. The ability to acquire and store an averaged sample
from the real-time mode is also included.

The LISST.EXE program has four major functions. They are:
process raw data, display processed data, acquire real-time data,
and process background scatter data

Raw data processing features include selecting a range of data to
process from a plot of the auxiliary parameters such as depth,
temperature, or transmitted laser power. This allows the user to
select particular events or profiles to process.

After processing the data it may be viewed on the screen. Some
features that are available while viewing the data are: timed
playback of size distribution and Volume Scattering function,
display of total suspended volume, display of mean size, display
of auxiliary parameters such as pressure and temperature, and
display of size and concentration at a point by mouse selection.

The ability to process data in real-time is also included. The size
distribution can be processed in real-time at about a 1 Hz rate.
The size distribution is displayed to the screen and stored to a file
at fixed rates or by individual samples. The ability to acquire a
background scatterfile or an averaged data sample is also
included.
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Step by Step Procedures for Data Analysis

The following step-by-step procedures have been written to assist the user in
learning the LISST.EXE program. All of the features of the software are
covered in simple step-by-step instructions. The software is described in the
following sections.

Build background
scatter file

Process raw data

View Particle size
data

The first step before processing the raw data is to process the
background scatterfile. This step-by-step procedure converts the
raw binary file into an averaged ASCII file. It also shows the user
how to check the quality of the background scatterfile and current
status of critical instrument parameters.

Data that has been downloaded from the datalogger is in a raw
binary file. It must be processed into particle size by the
LISST.EXE program. This step-by-step procedure covers the
processing steps including optional displays and procedures.

After processing of the data into a Particle Size Distribution
(PSD) file the data can be viewed to the screen. This step-by-step
procedure covers the viewing of data and optional displays.
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STEP BY STEP PROCEDURE: PROCESSING BACKGROUND SCATTERFILE

display. Double click name or type name and select
Open.

Open Raw Backzround Data File

£ Unitio3g -

Lizst Drata [*.raw; bin;*.dat) |_

Step Action Result
1 e Run Acquire Background option from the main Raw background scatter data
datalogger menu and download data. in a file.
See the Record and Store Background Scatterfile Step-
by-Step procedure for detailed instructions.
2 e Start LISST.EXE program Program started.
e Select Build Background Scatterfile from the File Build Background Scatterfile
menu selected.
3 e Select the name of the raw data from the file selection | Raw data file selected.
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4 e After selecting a raw data file a display will appear
showing the averaged background scatter data and the
factory background scatter data. This screen allows
the user to check the quality of the background scatter
file and current status of critical parameters such as
laser power and alignment. A typical display is
shown below.

Background Saatter Informarion E

2047

Rings
Factory Background Scattering

Average ring values exceed factory by a factor of at least 2.0 far 1 ring(z).
100 frames collected.

EEN [E=EE

Warnings and other information will be listed

Averaged background
scatterfile display to the
screen.

5 . The red line is the factory background scatterfile.
The file used for this display can be changed by
selecting the button above the plot. Press the button
and select the desired file from the file selection
window.

Background comparison file
selected.
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6 e  The scale of the plot can be selected by pressing the
+/- button. This will bring up the window shown
below.

Masimum Scle Setring |

It will allow the maximum scale of the display window
to be changed. Type in the desired value and select OK.

Scale of display selected.

7 J After reviewing the scattering file it may be stored
by selecting the Accept button. If file is not
acceptable, select Cancel and no file will be created.

Background scatterfile is
either accepted or canceled.

8 e If the file is accepted a file selection window will be
displayed and prompt for a name to store the average
ASCII file to.

Name selected and file saved.

Notes:
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STEP BY STEP PROCEDURE: PROCESSING RAW DATA

Step

Action

Result

1

e Start LISST.EXE program

e Select Output from the Options menu. The window
below will appear prompting for the desired output to
use for the future data processing. Note: this selection
must be made BEFORE starting the processing
command.

Output Options X |

— Realtime Inztrument D ata

B Euvild a binary rawe data file. [ raw]
7] Build an &5CH raw data file. | log)
] Build a binary particle size file. [ .pzd]
[Tl Build an &5C1 particle size file. [ .asc)
B Include Yolume Scattening Function in A5CH file,

— Flaw D ata File
[Tl Build an &5CI raw data file. | log)
B Euild a binary particle size file. | .psd)
] Build an ASCI particle size file. [ azc]
B Include Yolume Scattening Function in S5C11 file,

Selectionz do HOT apply to data sources already open.
Selectionz apply anly to subsequent openings.

N (o

Program started.

Note: A binary PSD file is
always created when
processing raw data. This is
used to display the processed
data to the screen.

The ASC type is a spaced
delimited file containing all
the processed data. Optionally
the volume scattering function
data can be included in this
file.

The LOG file is a space
delimited file containing the
raw data from the datalogger.
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Step Action Result
2 e Select Open Raw Datafile from the File menu Open Raw Datafile selected.
3 e Choose instrument type from the window shown Instrument type selected.
below.
Irstiument Model: JLISST 100-B [1 - 250 micron)
LISST 1004 [5 - 500 micron
LISST 1008 1 - EEE! rmicron]
All new instruments will be of type B - 1.25 to 250
microns. Older instruments may have the 5 to 500
micron range. After choosing type press OK.
4 e Select the raw data file from the file selection Raw data file selected.
window. Double click the file or type the file name
and press Open.
5 e Seclect the RingArea detector calibration file. This RingArea file selected.
file is specific to the instrument being used. Users
with multiple instruments will have multiple
RingArea files.
6 e Select the background scatter data file from the file Background scatterfile

selection window. Double click the file or type the
file name and press Open. This file must have been
previously processed into an ASCII file using the
Build Background Scatterfile command.

selected.
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7 e Select the output file from the file selection window.
Double click the file or type the file name and press
Open. The default name is the same as the raw data
with different extensions. If other output types are
selected they will have the same base name with
different extensions. Note: file types other than the
default PSD file must have been selected before
starting the Open Raw Datafile command. See step 1.

Output datafile selected.
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Step

Action

Result

A display similar to the one shown below will appear.

ha] LISST - C1039_03

¥ C1039_03

Laser In-Situ Scattering and Transmissometry (LISST)

Laser Power
Battery Yoltage

The top portion of the display is a graphical
representation of the raw data on the 32 rings. The
value of the 32 rings is represented as a vertical line
with time moving from left to right.

The lower portion of the display shows the time
history of some of the Auxiliary parameters. This can
be useful for determining when the instrument came
out of the water or when a particular profile was
started. This is useful for determining what range of
the datafile to process. Which Auxiliary parameters
to display can be set by selecting the Auxiliary
Parameter Display from the Options menu.

Auxiliary Parameters x|

Select supporting parameters ta dizplay

when proceszing a raw data file,

Lazer Power
Battery Yoltage
[ &uxi

[T Laser Reference
Pressure

[ Temperature
[ A2

[ 2

e | DC]

Note that only 400 samples of the Auxilary
Parameters are displayed at a time. Use the Next and
Previous buttons to move through the complete
datafile.

Main data processing

selection window displayed to

the screen.
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Step

Action

Result

Additional information is stored in the processed
datafile. The Auxiliary parameter window displays
these values for the current sample pointed to by the
vertical cursor. They will update as the cursor is
moved. The window is opened by selecting the Show
Auxiliary Parmeter Frame from the DataFrames
menu. An example of a similar window is shown

below. Labels may be different than below.

Laser Power

Battery

Extemal Instrument

Laser Reference: 467

Pressure

Temperature 1.79 deg C

Minutes

seconds

Tranzmizzion LEOE

s rwaths
B.6 walts
009 valts
riwatts

meters

S fraf ) e 2 RS 2
il B 5

[ Show raw data

Frame:

=

Auxiliary parameter window
displayed.

10

The raw scattering values can be graphically display
by selecting the View Rings command from the File
menu. An example of this display is shown below.

Rings

-
=
[=]

Transmlsslon (%)

4095

Rings
Background Scattering

Value of rings for current
frame displayed.

Laser Power {1302
Factory Lazer Power |2307.85
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Step

Action

Result

11

To select the range of raw data to process position the
cursor at the desired starting sample. The display at the
lower portion of the screen will show the current sample
or frame. Pressing Select First button will set the
current cursor position as the starting point for
processing. Similarly selecting Select Last will set the
end point for processing. Use the Next and Previous
buttons scroll through the complete datafile. The first and
last points do not need to be on the same displayed plot.

Range to process selected.

12 After selecting the range to process select the Process Processing Completed
File button. The display will show the processing
progress and the Process File button text will change to
Finished when the processing is complete. The window
can now be closed.
Notes:
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STEP BY STEP PROCEDURE: VIEW PROCESSED DATAFILE

Step Action Result
1 e Start LISST.EXE program Program started.

e Select Open Particle Distribution File from the File menu. Open Particle
Distribution File
selected.

2 e Select the processed data file from the file selection window. Processed datafile
Double click the file or type the file name and press Open. selected.
3 e After selecting the processed file a window similar to the one

shown below will appear.

kao LISST - C1039_05

¥ C1039_05

Laser In-Situ Scattering and Transmissometry (LISST)

Particle Size Distribution Volume Scattering Function +5
beam ¢ =3.716

10

05 17 250 17 71
microns milliradians

Mean: 69.37 Data Frame: 14

Sid Dev: 27.47
Total Vol Conc: 39 43

S_gq_u_oia Scientific, Inc.

Serunia Sciertific, Inc

Twmee| o] | [ o] o [Reno] ] o |

The left hand display is the volume distribution in unit of

micro-liters/liter in each size class. The right hand display is
the Volume Scattering Function. In future versions the right
hand display will have a number of different display options.
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Step

Action

Result

Only a single sample is displayed at a time. By using the
buttons on the bottom of the display it is possible to
manually or automatically step through the datafile. The
Timer button will step through the datafile by updating the
display at a fixed rate. The rate is set by the slider bar next to
the timer button.

Additional information is stored in the processed datafile.
The Auxiliary parameter window displays these values for
the current sample. They will update as the Volume
distribution is changed. The window is opened by selecting
the Show Auxiliary Parameters Frame from the DataFrames
menu. An example of a similar window is shown below

riwatts

=
«o

=] =] =] =] =] =11
R A I m
m

Laser Power

Battery wolts

Extemal Instrument wolts

Laser Reference 486 rwatts
Pressure . meters
Temperature 159 degC
Minutes

seconds

[=]
o
o

Tranzmission

Frame: |14

[ ]

The scale of the Volume Distribution plot can be changed by
using the Display button. After selecting the button a display
similar to the one shown below will prompt you for the
maximum concentration for the Y-axis of the plot.

Display Parameters x|

Header Text: |Laser In-Situ Scattering and Transmizzometry (LISS |

Footer Text: |Sequ0ia Scientific, Inc. |

i

W airmurn ordinate value: |1

Animation frame intereal: (500 millisec

[[] Show mean on plat
[ Show +4- one standard desviation on plat

E==0 TR

Other options are also available for customizing the display
such as changing the header and footer text or adding lines to
show the mean and standard deviation.

Display setting
modified.
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Step

Action

Result

The current display can be sent to the print by choosing Print

from the File menu.

Display printed.

When finished viewing the processed data close the window

Viewing of data
complete.

Notes:
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Performance Tips

This section contains some tips on the use and maintenance of the
LISST-Deep.

The LISST-Deep is a high-precision optical instrument. Rough
handling will damage the internal optics and critical alignments.
When mounting the instrument to a CTD frame, tripod, mooring,
or other fixture, protect the instrument from mechanical shocks or
impacts.

During long-term deployments, biological growth can occur on
the instrument and windows. "Bio-fouling" of the windows can
change the background scattering pattern. Similarly, sediment
settling on the windows can cause problems. To reduce these
problems, it is recommended that the instrument be mounted so
that the faces of the windows are vertical.

The transmissometer community has tried different approaches
with varying degrees of success. We are experimenting with the
poisons and other techniques currently in use in the community to
determine which will work best for the LISST-Deep. In addition
to poisons, another strategy is to obtain a ZSCAT at the end of an
experiment. The ZSCAT must be done without disturbing the
growth on the window. This post-experiment measurement can
be used to make estimates of errors induced by bio-fouling.

The LISST-Deep is relatively insensitive to natural lighting.
However, it is recommended when working in shallow water that
the optics end of the case be pointed away from any bright light
source.
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Instrument Storage & Maintenance

Again it must be emphasized that the LISST-Deep is a sensitive
instrument. When not in use, the instrument should be stored in a
well padded case. For longer storage (year or so), the
communication cable should be disconnected and the battery pack
should be disconnected or removed. If you do not wish to remove
the battery or disconnect it, battery life can be prolonged with the
use sleep mode.

As has been noted earlier, the condition of the windows is critical
to the performance of the LISST-Deep. Care must be taken when
cleaning the windows. The windows and the instrument should
be rinsed thoroughly with fresh water after each deployment. The
windows should be cleaned with a soft cloth or lens tissue.
Liquid detergent/soap and water may be used. For removing
grease spots, finger prints etc. Alcohol may be used. We
recommend against the use of stronger solvents such as Acetone
or Toluene.

Cleaning Windows

Abrasive powders must never be used near the optics
windows, they will scratch the windows and degrade
instrument performance.

O-Rings
O-rings that seal the mating parts of the instrument must be
maintained and inspected regularly. Whenever the end cap is
removed, check the o-ring for any cuts or marks, and clean and
lightly grease the o-ring before installing the end cap. Spare end
cap o-rings have been provided. O-rings are inexpensive items
that provide an invaluable service; replace them if there is any
doubt about their condition. When replacing the O-ring, be sure
to clean the O-ring groove thoroughly with cotton-swabs etc.
making sure that no fibers or particles of dirt are left after the
cleaning. The part numbers for the endcap o-rings are: Parker
Part #2-236-N70 (radial), #2-240-N70 (face)

Battery The LISST-Deep uses four standard size 9V alkaline batteries

Replacement which are attached to the connector endcap. This endcap can be
removed to access the battery. Remove the six bolts holding
endcap to the case. Special Note for Titanium units: These bolts
are special bolts made of titanium. Do not use stainless steel
bolts. After removing the bolts carefully pull the electronics from
the case as shown below.
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The batteries are held in standard holders. Remove the batteries
and replace with new. To increase battery capacity the alkaline

batteries can be replaced with lithium 9V batteries. The battery
holders are shown below.
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The LISST-Deep should not require any adjustment or
calibrations. The pressure and temperature sensors can be re-
calibrated if desired. The performance of the instrument can be
checked with the use of a sample of particles of a known size
distribution.

A large drop in the laser transmission reading, which may be
noticed while doing a new ZSCAT between deployments, may
suggest that the instrument has become misaligned. As discussed
earlier, the laser beam passes through a small hole in the center of
the ring detector. If the instrument is subjected to a hard impact,
the optics alignment could change thus causing the beam to not
go through the hole. The laser beam will then scatter some or
possibly all of its power onto the ring detector thus saturating the
detector. If the recorded value of laser power transmitted drops
abruptly, the LISST-Deep will need to be returned to the factory
for realignment.
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Appendix A

Technical Specifications

Parameters measured/derived
size distribution
volume scattering function (VSF)
optical transmission

Optical path length: 20 cm standard

Optical transmission: 12 bit resolution

Particle size range: 1.2 - 250 micron diameter

Resolution: 32 size classes, log-spaced

VSF angle range: 1.7 to 340 mrad

Data storage memory: 512K (6500 samples)

Maximum sample speed: 4 size distributions per second (standard)

Depth rating: 5000 m

Battery Capacity: Standard: four 9V Alkaline batteries (2 amp-hr)
Optional: four 9V Lithium batteries (4.8 amp-hr)

External Power Input: 9V (5.5V to 12.0V)

Current Drain: 180ma sampling, 3.3ma idle, 0.08ma sleep (measured at 9V)

Endcap O-rings: Parker Part #2-236-N70 (radial), #2-240-N70 (face)

Endcap Bolts: 10-24UNC x 1.5in long socket head cap screws

Special Notes for Titanium Version of LISST-Deep:
All exposed bolts are special titanium bolts. They are NOT stainless steel. Extra
endcap bolts have been provided. Only titanium hardware should be used.

Communication and Power Connector wiring

Pin# Color Use

1

B W N

White  External Power Ground
Black  External Power 9V
Blue Serial Ground
Orange Serial Out
Green  Serial In

Pins labeled on connector
Connector = Impulse Part # XSJ-5-BCR
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Appendix B

Size Ranges

Size Ranges, Angles of Observation and Data Storage Format

There are 32 size ranges logarithmically placed from 1.25 - 250

microns in diameter. (the upper size in each bin is 1.180 times the
lower).
The table below shows the median size of each size class. For
clarity the table is shown with multiple rows. In the output data
file the data for each size class is oriented in one row from small
to large.

Type B Instruments — 1.25 to 250 micron size range

1.36 1.60 1.89 2.23 2.63 3.11 3.67 4.33
5.11 6.03 7.11 8.39 9.90 11.7 13.8 16.3
19.2 22.7 26.7 31.6 37.2 44.0 51.9 61.2
72.2 85.2 101 119 140 165 195 230
Type C Instruments — 2.50 to 500 micron size range
2.73 3.22 3.80 4.48 5.29 6.24 7.36 8.69
10.2 12.1 14.3 16.8 19.9 23.5 27.7 32.7
38.5 45.5 53.7 63.3 74.7 88.2 104 128
157 186 219 259 293 332 391 462
Angles The median angles (in Degrees) for the VSF measurement are
shown in the table below.
Type B Instruments — 1.25 to 250 micron size range
0.106 0.125 0.148 0.174 0.206 0.243 0.287 0.338
0.40 0.47 0.56 0.66 0.77 0.91 1.08 1.27
1.50 1.77 2.09 2.46 2.91 3.43 4.05 4.78
5.64 6.65 7.85 9.26 10.93 12.90 15.22 17.96
Type C Instruments — 2.50 to 500 micron size range
0.053 0.063 0.074 0.087 0.103 0.121 0.143 0.169
0.20 0.24 0.28 0.33 0.39 0.46 0.54 0.64
0.75 0.89 1.04 1.23 1.45 1.72 2.02 2.39
2.82 3.33 3.93 4.63 5.47 6.45 7.61 8.98
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Raw Data Storage The values in the raw data file are stored in the order shown in the
Format table below.

Elements Parameter

1:32 Light intensity on detectors 1 through 32
33 Laser transmission Sensor

34 Battery voltage *100

35 Sample Number

36 Laser Reference sensor

37 Spare

38 Year*100 + Month

39 Day*100 + Hour

40 Minutes *100 + Seconds

Processed Data  The values in the processed data file are stored in the order shown
Storage Format in the table below. Each sample is stored in one row.

Elements Parameter
1:32 Volume concentration (in ul/l) for size class 1
(smallest) through 32 (largest)
33 Laser transmission Sensor in calibrated units
34 Battery voltage in calibrated units
35 Sample Number
36 Laser Reference sensor in calibrated units
37 Spare
38 Year*100 + Month
39 Day*100 + Hour
40 Minutes *100 + Seconds
41 Computed % Optical transmission over path
42 Computed Beam-C in units of 1/m
(Optional) Volume Scattering Function for 32 angles from
43-75 small to large
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Appendix C

LISST-Deep Instrument Troubleshooting

The following flowchart provides a set of procedures to follow if the LISST-Deep instrument is not
displaying text to the TFTOOLS terminal screen or is not responsive to commands. Follow the
procedure outlined below before executing a Hard reset as described on the next page.
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LISST-Deep Instrument Reset Procedures

| Step 1: Follow LISST-Deep Troubleshooting Flowchart to confirm that a Reset is required.
| Step 2: Document preceding and current conditions leading up to need for reset.

| Step 3: Open Case and disconnect 2 pin backup battery connector. Main battery should be
above 6V or higher.

Insert labeled picture of board end.

| Step 4: Disconnect main battery and wait 30 seconds.

| Step 5: Connect communications cable and start TFTOOLS.

Q Step 6: Re-apply main battery or external power. Program will start running in about 20 to 30
seconds. Stop program by Typing a CTRL-C to bring up Main menu.

Q Step 7: Exit program to # prompt by choosing option 7 from Main menu.

Q Step 8: Download data from instrument using TFTOOLS. Note the data is secure in flash
RAM. It will only be lost if written over. However the pointer to memory is reset to zero after a
reset. When prompted for the number of bytes to offload it will default to 0. Manually enter the
number of bytes to offload. Each sample is 80 bytes. Compute the number of bytes to offload or
enter 483000 to download the complete datafile. When downloading the complete datafile there
may be some strange values at the end of the file. These strange values may cause errors when
processing the data with the standard LISST software. If this occurs try downloading a smaller
file in addition to the full memory file.

| Step 9: After confirming data download, erase the data file using the Erase Datafile command
in TFTOOLS.

| Step 10: Execute Acquire Background 4 time to store dummy data. This clears and buffers that
may still contain some old values.

Q Step 11: Erase data file again.

Q Step 12: Restart program. Put into Data Collection mode or Sleep mode.
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